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Teacher’s Introduction
This resource has been compiled to help support students to learn and develop m

practical production skills in preparation for completing their chosen NEA brief as Pages from this resource
outlined in the AQA (8572) GCSE (9—-1) Media Studies specification. This resource .

. . . . . . . should not be submitted
is designed to support students in the production of print media, specifically . ;
newspapers, magazines and advertising/marketing products. orassessment.

For many students, the NEA will be their first experience of producing a media product independently. This pack
is compiled in a way that describes the core elements of the NEA brief (as outlined by the AQA specification) in
detail before offering students a comprehensive guide to the relevant skills needed to research, plan and execute
their practical projects. This resource offers a general guideline of the skills students will need to complete their
newspaper, magazine or advertising/marketing product. This resource can be applied to any brief supplied by
the exam board, and therefore may be used year after year to support students. It should not, however, be used
as a direct source of ideas for their NEA.

Each section for this resource has been designed to slowly build confidence for students in fully understanding
the NEA brief, analysing relevant media products and applying these skills to their own practical production. The
pack begins by outlining the NEAs which fit into the category of print media, in this case newspapers, magazines
and advertising/marketing products. This opening section sets out the criteria that the student’s work will be
assessed against: a statement of intent (10 marks); a media product which demonstrates confident and skilful use
of media language (15 marks); a media product which demonstrates a capacity to form representations

(15 marks); and a media product which meets all aspects of the brief and that effectively communicates meaning
(20 marks). Furthermore, a clear breakdown of the restrictions, limitations and means of documenting the
production process are provided for students to read. The resource then provides a useful summary of the
technical codes and conventions of newspapers, magazines and advertising/marketing products, as well as a
comprehensive list of the core genres and sub-genres within these media forms.

The remainder of the pack takes the student, step by step,
through the process of completing their NEA. The guide
begins by encouraging students to explore ways in which they
can initially plan their projects through the production of
mind maps, pitches, mock drafts, etc. The pack then offers a
general guide through the research and planning stages of the

This resource is intended only to supplement O
your teaching. As with all non-exam assessment
tasks, it is the teacher’s responsibility to decide
what level of support is appropriate for their

students and in accordance with the rules from

project. Please note: the planning section of this resource the exam board.

contains an example statement of aims. It is up to you to

decide how you use this with your class. The main body of The resources here are provided as the author’s
the guide will explore the specific technical skills required for interpretation of the specification. The author,
the production of print-based content. Tasks are varied by does not have any special knowledge of what to

way of annotations of media products, creative activities and expect on any particular assessment.

short written analyses to allow for deeper exploration of
understanding. The resource will also include a number of completed analyses for students to study, practical
tips, step-by-step guides and examples of effective use of media language in relevant media products.

A glossary of terms is provided at the end of the resource, as is a further reading / viewing section for students
who wish to broaden their knowledge and strengthen their skills. Tasks that require answers of a specific or an
indicative nature can be found in the answer sheets located in the answer section at the back of the resource. By
the end of this resource, students will have gained an idea of how to plan their time and structure their practical
project. They will also acquire the confidence to approach their NEAs with creativity and innovation while
fulfilling the requirements of the AQA specification.

Colour copies of selected pages from this resource can be accessed via our free updates system (zzed.uk/freeupdates).

July 2019

Free Updates!

Register your email address t y future free updates* made
to this resource or other Media Studies resources your school has
purchased, and details of any promotions for your subject.

* resulting from minor specification changes, suggestions from teachers
and peer reviews, or occasional errors reported by customers

Go to zzed.uk/freeupdates
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NEA Outlines — Print-based

The NEA or ‘Non-exam Assessment’ is the ‘coursework’ part of your Media Stu
the final exam at the end of the course. It is an ongoing project involving the p
a media product to a given brief. This resource is designed to equip you with t
create a print-based media product, which will be in the form of either a magaz
advertising/marketing product. ~

The Non-exam Assessment (NEA) is worth & v g =N xd%éi, making it 30% of t

o

assessment breakdown works asf2liyi:

15 marlkg

o 'eo.mg a medla product which constructs clear and effective
eauc"““"“
e ating a media product which meets the requirements of the br

**|n addition to your practical project, a statement of intent will heed to be submitted. In essen
how you plan to apply knowledge of media language and representation to the creation of a pro
conventions of the chosen genre and which effectively appeals to a particular target audience. T
300 words. Your teacher will provide you with a full template, into which you will write your sta

As mentioned, you will be asked to produce a print-based media product from
project briefs will change on a year-by-year basis and, as such, the requirement
from those provided below):

: ®  Magazine Print-based Product
You are required to produce a front cover, as well as a double-page feat
The magazine must fit into a specified genre, fulfil a specified aim and ap
audience, all of which will be specified by the brief glven to you by your
¢ Newspaper Print-based Product A
You are required to produce a front page, a3 #ii f' a 3 ature page for a
newspaper must fit mto a particule' G e ! appeal o a particular tar,

Assessed Materials

You will be assessed on your media product and your cover sheet (which shoul
intent). You will not need to submit research or planning material, although yo
teacher evidence of research and planning throughout the 12-week process. T
stages will be assessed.

Restrictions and Limitations

e The required length of each project will be specified on a brief-by-brief ba
double-page spread for an original magazine.

e  The upper limits set out by the specification should not be exceeded. For
advertising/marketing material beyond that whtch thy > ef specifies, this
marked for examination. = |

e  Under no circumstances should unozoh e des ’6r text be used in the cr

*  Students will have their mar . g Ay affected if they produce materia
the target audience .. 2

e  Print- b" x L iwbe submitted electronically, so quality of printing

og\on

Managing an¥&g#ing Tlmes
The amount of tame you spend on your project {from the initial analysis of exist
touches of your production) is theoretically limitless, but it is recommended th
30 hours on the project. Deadlines for each stage of the production process wi

is your responsibility to ensure that your product and coversheet are ready in t

GCSE (9-1) AQA NEA Practical Skills Pack: Print Page 2 of 46
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NEA Checklists — Print-based

There are essential elements which must feature in your final media product, de;
you chose to follow. You may find it useful to tick each element off as you progr:
project. NB the project briefs will change on a year-by- year h 5|s and, as such, tt
briefs may differ slightly from those provided below

{ Magarine

i Essential Content

i e Thr

i« Five g@“"n
front Cover
¢ Original masthead
* Sell line

e Cover price

. Dateline

*  An original main cover image
e Four or more coverlines

Double page Spread

: Headline

i« Standfirst

e  Subheadings

¢+ Anoriginal main image

*  Three or more original, smaller aH*' :

Pullquotes /sidebar v~ 5

»  Featurearticle (v .-
the glilhov -

Newspaper G
Essential Content

e Consistent sense of brand identity

«  Consistent application of house style

e Suitable mode of address

e Approximately 400 words of original copy

: Front Page
: Masthead
. Dateline

e Ancriginal main image

* Atleast one enigma code
¢ Headline

e  Original text

GCSE (9-1) AQA NEA Practical Skills Pack: Print Page 3 of 46
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. Feature Page

¢ Headline

e Standfirst

*  Subheadings

*  Byline

¢ Original text relevant to the front page lea
¢ Four or more original i 1mages L

Print Adverti Advertlsement

e Thre EZ%O ent advert|sements

«  Acommon house style across all three products
¢ No fewer than five images across the three pages, including one main im
¢ All three main images must convey a narrative and include one or more
e Original text (usually 70 words or more)

¢  Alogo design (depending on the product or campaign)

¢ Colours and typography that convey appropriate meaning

Indicative/Advisable Content - ALL Three Forms

* Invocation of a clear house style

¢ Suitable application of codes and conventions

¢  Asuitable concept which appeals to the specified target audience
«  Images constructed with a sophisticated mise en =2>  with appropriate

=

+ Images and copy are integrated effectively

e Use of intertextuality g
«  Content which combate » sdl / 1 wstereotypical representations

AdOD NOILO4dSNI

DONT FORGET!

It is extremely likely that the set briefs will require you to produ
print media, e.g. a music magazine, a video game magazine, a TV
magazine, a vlogger marketing campaign or a video game mar

Briefs such as this will require you to conduct research on the cod
context surrounding multiple media forms.

.

COPYRIGHT
PROTECTED
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» ons of Media

As you will have discovered from your media les: ; ent technical and generic conventio
pack, we will focus on the codes and co”. 1 .@agazines, newspapers and print advertisements
‘ “as part of your research process for your project, whic

helpsto | Print Advertisement
and contributes |

to branding the product, e.g. the
digitally produced icicle effect mirrors
the desired state of the product

Tagline/Slogan: One punchy line which
ensures that the advert is retained in
the audience's memory, e.g. the promise
of saving time is a huge selling point

Mode of Address: The type of
language used to speak to audiences,
e.g. directly addresses the audience o

‘you’, and provides full instr:

walking the audiesgs thr i h

o SNE R

1in body of text
describing the benefits and mechanisms
of a product or service, e.g. instructions
and benefits of the freeze paper are
explained

Colour Scheme: The repeated group
of colours used to create a particular
tone or house style, e.g. generally blue
and white colour scheme inviting
connofations of snow and fresh wate

Glacial Beer Advert © Brasil Kirin, 2015

isement unique is its interactive nature — the ad itself contains salt particles, and when
frozen, it cools the beer a lot quick

GCSE (9-1) AQA NEA Practical Skills Pack: Print Page 5 of 46
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Newspaper Front Page

Masthead Caption: Typical of
a tabloid newspaper —
summarises the appeal of the
publication, e.g. ‘Fighting for
you’ directly addresses the
reader and promises to report

with the reader’s interest in mind

publication,
most tabloids this
appears within the
red top

Masthead: The title
of the publication,
designed and
displayed on the
front page, e.g. the
Daily Mirror headline
is always positioned
in the fop-left corner
of the stage so it
stands out among the
competition

Main Image: Usually

a visual
accompanimaat to. o 4

the main s W

this case

coincide with the main
headline — this is rare

Secondary Headline:
The title of a slightly
less important article,
e.g. written in the first
person to make
readers feel more
connected to Lisa Riley

characteristic of several
British tabloid newspape: -
so named becar: . 11 1 ¢
red masthe. x5,

-

Red Top: A key

1

£

Iy ’},A.andﬂf. e Daily

Secondary Imag
visual context f
key news story,

into camera is hig

Fi}FP( N char%es for hospital patients

staff and visitors hit a record £175m

Banner Advert: A key way in
which newspapers can make

the reader by offering.» 51 .

R .
1?994  about dedls in
o

wosco

money; provides an incentive fo

Lo he

Sub® i d: A e
v de, normally

« xpréssed in one line, e.g.

emotive longuage — ‘Fury’
— infused with shocking
statistics — ‘record £175m’

The Daily Mirror © Reach PLC, 2017

minimal amo
front page,
tabloids (tha

visually ¢

This front page is from the Daily Mirror, a British national tabloid newspaper. This e

AdOD NOILO4dSNI

COPYRIGHT
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and conventions currently associated with newspap
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Headline: The title of the article,
summarising the topic, e.g. fypicaily
formal of o broadsheet newspaper
with political subject matter

Standfirst: 4

information,

story or teasi

out more, e.g. provides new

information rather than simply
repeating the headline

Byline: The name of the author, e.g.
reveals Tim Shipman’s job — ‘Polifical
Editor’ — as well as his name

Body Text: The main text of the
article, e.g. proportion of text to
imagery is much higher than it would
be in a tabloid newspaper — agimed ot
a more highly educated audic.:

oororon

Frames: 'L\Eg Lftcinof o
different ccXRG@®iwn around
certain sections af the body text to
break if up, e.g. makes the
countdown stages before Britain
leaves the EU stand out

Newspaper Feature

‘pakthroughion rish border
wigs Tory robols

Colour Scheme: The repeated
group of colours used to create a
particular fone or house style, e.g.
broadsheets tend fo utilise black and
white — this page scarcely uses red
and blue fo invoke the image of th-
Union flag, which would b~ i+
for o st Ut . -

The Times © News UK, 2018

This feature page is from The Times, a British national broa
example contains many of the codes and conventions cu
newspapers.

GCSE (9-1) AQA NEA Practical Skills Pack: Print
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Magazine Front Cover

Strapline: A hook or tag line used to gain
audience interest, directly related to
articles within the issue, e.g. top positioning
and the use of rhyme in ‘clash’ and ‘smash’
make this stand out among the other
coverlines

Masthead: The title of the publicati
designed and displayed on the fro

page, e.g. Mojo is hidden behind
Hendrix’s af ~, - ggesting confiden

rn . rogazines confent

Pug: Pieces of
information I

are used to oftract
the attention of the
audience and draw
them into the
magazine, e.g. a free
CD would be
attractive for a music
magazine's audience

Main Coverline:
One of the titles from
the cover page,
considered the main
title. Often
corresponds fo the
main image /model
of that issue, e.g. it is
testament to

AdOD NOILO4dSNI

on words

Tag: Phrases used to
catch the audience’s
attention. Also
referred to as buzz
words, e.g. the word
‘plus’ is one of the
most common
examples of this

COPYRIGHT
PROTECTED

Thirds: A magazine cover is always split Mc ni. ~ . Magazines typically
into three equal horizontal and vertical ' saw«e one image (also known as
sections called thirds. These are use o, '~ " the cover image), often of a
selling purposes and to gre >+ & celebrity, that ties into the themes of
attention, e.o g — {1 - "+ o that issue, e.g. Hendrix has an iconic
and extras, \- ¢ oral sense of style which cudiences will

image/mast XEega@aht — main coverlines associate with 1960s rock music

'9

)

Education

Mojo fits into the genre of music magazine. The cover pictured above contain
conventions found in magazines. Notable exceptions are the cover pric

GCSE (9-1) AQA NEA Practical Skills Pack: Print

Page 8 of 46



Standfirst: A brief summary of an article

Text Style: Font is often smal

reflect the style and genre
magazine, e.g. columns are o
for interview-based articles f

Feature Article: Often
in small print, the main
body of content for a
particular article.
Provides the most
detailed information,
e.g. in this case Robert
Pattinson’s interview
answers

Subheadings:
Headings which
separate bodies of

questions

Additional Smatler
Images: Provide
visual context for the
reader about the
story and makes the
page more visually
engaging, e.g. pictures
of Pattinson with
girlfriend, Krister
Stewart

Robert Patt 22»13

Kristen Needs

sl astmiirahyons ad
4

Look fits into the genre of women’s lifestyle magazine focusing on hig
fashion and celebrity gossip.

GCSE (9-1) AQA NEA Practical Skills Pack: Print

Page 9 of 46
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Genres and Niche Gen

For your NEA, you will be asked to create a product which fits into a particular ty
vary in their use of colour, typography, political alignment, etc., there are gener

newspaper.

Newspapers {Tabloid vs Broadsheet vs Free

sheet! -~

Traditionally higher readersh
»  Sensationalist headlines
e  Target audience (C1,C2,D, E
*  Proportion of image to text is
Tabloid e Greater use of bold typeface
e TheSun e Larger font size
e Daily Mirror e Shorter article length
e  Daily Star e Headlines often feature laym
e  Daily Express terminology)
e Morning Star e Use of colloquial language (e
e Daily Mail e Focus on celebrity gossip
e  Focus on human interest stor
e Extremely obvious political st
e  Often includes discount code
o News stories are mostly natio
e Greater . :of imperatives a
o _..¢ ge¢ : anvore educated aud
. Zintains more informative co
e Broadsheet ‘o F.oc%xs on ‘serious’ issues, e.g.
e The Daikareluisii . e Limited .use of coIour. .
WY i . Proportion of text to images i
¢ e Articles are longer in length
¢ e  More likely to include facts, s
¢ ) e Covers both national and inte
e TheTimes . .
. - e  Contains cultural inserts
e  The Financial Times - .
e  Political alignments are revea
e  Reporting tends to be more i
e Target audience (A, B, C1, C2
e  Less emphasis is placed on hu
e  Freesheet e  Free of charge
e Metro e  Targets urban audiences
e  The Shuttle ¢  Makes money through adver
e  Evening Standard e Some refe";nble tabloids; som

TOP TIP: The briefve e t“v-d clarify whether you should be wr
_.“publication. Use this table to ensure your
), . .ace target audience.

broadsheet ¢ .-

w7

GCSE (9-1) AQA NEA Practical Skills Pack: Print
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Magazine Genres
Magazines encompass a wide range of genres and niche genres. Listed below are jus

Genres Women’s Men’s Enterta
e Fil
*  (Celebrity gossip < Men’s fitness tm
. . e TV
»  Bridal and weddings < Auto . Gamin
Niche +  Fashion and beauty Tl &
i Y i *  Celebrit
Genres . Home and cooking 25 S V:,a,»,@'thletlcs .
| *  Music
- “Weaponry .
, . o Sci-fi
*  Men's fashion
e Art
Genres Teen Hob
e Artsand
*  Comic books * Auto
. . + Dance * Comics
¢ International living .
. . . *  Gymnastics *  Puzzles/
Niche ¢ Holidays/Leisure . .
. * Gaming *  Sci-fi
Genres e Home/Decorating .
i * Teen fashion *  Toys/Co
¢ Recreation -
. e Skating e Woodw
¢ Fashion and beauty .
* Teen lifestyle e Comput
*  Photogr
' 4
TOP TIP: Notice how TOP TIP: Do not underestimate the importance of
many of the niche | between similar niche genres. For example, the
genres overlap!l 2" ™ magazines will differ massively from the target
. G F magazines, even though both would technicall
Print Advertisements

Itis signific '*‘ig for ¢ Anficult to officially categorise genres and subgenres of
below demcREZg#¥e how print advertisements can appear in a number of differ

number of different purposes.

Print advertisements can appear
infon:

magazines

newspapers
pamphlets pr
DVD cases pr
billboards
posters

public tran poi L

promo

GCSE (9-1) AQA NEA Practical Skills Pack: Print Page 11 of 46
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Initial Ideas

Once you have received your NEA brief, it will be up to you to start thinking abo
want to create. While your project is bound to be shaped by the research and p
there are certain exercises you can try out to help you formulate and develop an
presents just three ways in which you might want to draw out initial ideas. Exa

Themes: Loneliness . Wlain Image: Three
isolation, friza.gne o 21-year-olds,
dico e g e wadealth nightclub,
classroom, park.
Everyone in black
and white; main
characters in colour.

Working Slogan:
You can't just
make other people
hanny

v

Colourful, Ky -go-
lucky rmain character
— feeling isolated
from friends and
colleagues

Government-
funded / Mental
health / Students
aged 16-25

Persuasive
Techniques: Three
leads staring into
frame; direct

address: ‘you’;
Key Components: Mental health helpline, imperatives: ‘call

statistics about anxiety and depression among this service’

Brief: Print advertisements for a government-funded campaign to tackle mental health
issues among university students, aimed at 16—-25-year-olds.

Z
%
2
S
)
—
O
Z
®
O
3
—<

COPYRIGHT
PROTECTED

Brief: A magazine to promote an up-and-coming urban radio DJ, aimed at 13-18-year-olds

Title: The Sunday Scoop

Type of Newspaper: Tabloid

Reach: Regional

Demographic: Ages 18-45, predominantly female, white, working class
Psychographic: Left-wing, anti-Brexit, feminist ideals, focus on human interest
stories, personal injustices and celebrity scandals

Main Story: ‘Dozens hospitalised after Brexit-themed stag party’

Related Background Story: The wife-to-be’s side of the story

Image ldeas: Female police officer separating a man {whao is wearing a Union flag
jumper) and a young woman who are fighting / Secondary image — two members
of the stag party have bloody noses and are sitting on the pavi it, arms
around each other / Feature page — close-up of fiancs i 5v 12 do'an interview
Ideas for Intertextuality: Subhead — ‘I think...o st cEAVE right now...,

‘... the pound’s getting weaker —sir_ o © . ** Jiughtciub to Wilf Young’s ‘Leave

Right Now’ g

Subverted Stcgatyp c 2. o2 police officer willing and able to break up the

brawl / Rar 'fo) ‘ac wns'among members of the stag party — some tried their 09
o

best to previRege® fighting, comforted each other afterwards

Education

Brief: A local tabloid newspaper aimed at young local adults

GCSE (9-1) AQA NEA Practical Skills Pack: Print Page 12 of 46




Research

Before you begin creating your media product, it is crucial that you understand your targ
codes and conventions of media language to appeal to them. It is, therefore, crucial that
research into the type of media product you intend to make.

Analysing Existing Products

One of the most useful forms of research you cd
and target aud;ence to the one you pla ‘

~target audience.

Cultural Inserts: Sinéad
QO'Connor — suggests an older
audience; focus on career and
life stories rather than scandals

The world stands dlsgraced

Headline: Quotation marks —
frank rather than sensationalist;
however, still emotive and
challenges reader

Standfirst: Three bullet points
{rule of three emphasises
message} — facts and figures
summarise the story

Typography: Much smailer
typeface — allows more
information to be includer’

less urgent Eé,,,co i headline —
‘Cameron’ asstmes reader
knowledge The Guardian © Guardian media Group, 2014

Media Representation

FITMESS AWARDS! The BEST GEAR ol the Bast P

Coverlines: Focus on stereotypically
male issues from fitness regimes to
grilling tips. Repetition of commands
such as ‘shred your arms’ and ‘get wild’
represent the ideal men as active go- E AN
getters. Also an emphasis on a TOUGH
masculine ideai of being macho through ~BoxYourWayFit
words such as ‘tough’ and ‘warriors’ reskuntow Roaum

Tag: ‘Peck sex!’- Producers assume o
widespread male inferest in se

Justin Theroux'15 used to demonsirate
masculine strength and success. He
wears a gold watch and makes eye
contact with the reader, as if
challenging them to reach his level

Men’s Health (Magazine) © Rodale Press, 2018

GCSE (9-1) AQA NEA Practical Skills Pack: Print Page 13 of 46

AdOD NOILO4dSNI

COPYRIGHT
PROTECTED

'9

)

Education




Media Audiences

Tagline/Slogan: Constructs an
enigma — ‘Guess which one’ is an
imperative, insfruciing the audience

fo solve °“ke”ig:‘°;§hef”rp“i ONE CHILD IS HOLDING SOMETHING
gnswermokes e c . 1°S BEEN BANNED IN AMERICA

'll‘i;g : TO PROTECT THEM
ol

Characters: L =y = of Propp’s
character type W 5ms Demand
Action is the dispatcher, the audience
is the hero (with the power to take
action), the two children are the
princess (who must be protected),
and the assault rifle is the villain
(who threatens everyone).

Cultural Codes: Library setting and
appearance of Liffle Red Riding
Hood — society recognises
storytelling as a crucial milestone in
the development of young children

from pink and yellow clothes

Action Codes: The assault rifle
connotes violence and death —
something bad will happen if the ‘One child is holding something that's been banned in America to protect the
audience fails to act

TOP TIP: Notice that these e

yourself to apply as many of these as possible to your own product.

GCSE (9-1) AQA NEA Practical Skills Pack: Print Page 14 of 4
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Primary and Secondary Research

Beyond your analysis of existing media products, you will have to strike an effec
research and secondary research in order to further your understanding of med
= e e e e e e i i
! Primary Research: Refers to research you will conduct yourself in order to ans
i related to your project.
1
1
1

Secondary Research: Refers to information you il g ér _om the publicly a

Primary Research

In order to Coggact - 315: ; search you will have to gather some information
resources. “og 31\, ses of ex1st|ng media products from the previous page wou
there are aoXgge®al methods you can use:

e An audrence questionnaire/survey: Make a list of questions you want your
hand these out to people who fit into this demographic. This form of prima
for yes or no questions or multiple choice questions.

e Interviews: If you would like to receive more complex answers from your ta
individual interviews. You may want to ask an interviewee to explain the pl
from certain media products or answer closed questions such as ‘Do you th
representation in video game magazines?’

e  Focus group: Invite people who fit into your audience demographic for a sm
ask them to discuss the newspapers they read or the print advertisements t
You could even get them to discuss some of your early drafts.

Note: If you choose to hold interviews or focus groups, you may wish to record
responses. Ensure that you get permission from all participarts. Furthermore,
should not use strangers to collect your primary rese?""L\ - ‘¢t should be able to

your fellow classmates, siblings, teachers or pore: tSf Jl,duct effective researc

Secondary Research W
Secondary resp’"’ch L yoeato further your understanding of how audience
respond to "',n 3 e products and support your analysis. You may also find
useful to ex; i._éuc‘:‘ magazines, newspapers and print advertisements have hi
targeted their audiences. Appropriate secondary research can be completed usi
Internet, books, videos, documentaries and existing media products. Check out t

recommended list of further reading found on p. 42 of this resource.

When it comes to picking out existing media products to analyse, be sure to fam
contexts in which they were produced. Ask yourself the following:

I N
Magazines

» What is the magazine’s circulation/readership? e Whatis the paper’

*  Where is the magazine sold? s How much does e

+ Does the magazine offer digital editions? * Are digital edition

+  Who does the magazine claim to appeal to? = Whatis the demo

» How long has the magazine been running for? - What is the psychc
L What controversie

*  What do these answers reveal about the o

audience? Which conglomera

How is the paper fi

¢ o o o

£

.

Print Advertisements
Is the advertisement selling a product or a service?
Is the advertisement promoting a charity or social camp
Is it part of a cross-media campaign?
Is the advert considered controversial?
Was the advert produced under a media conglomerate?
Who is being targeted?

o O o o o o

\
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Planning

Planning Techniques

As you approach the final stages of your research, you can start planning the ex
Whichever NEA brief you choose to follow, there will b2 « is of tasks you will
underestimate the power of planning. Once y2u av. =
draft statement of intent, which you <! ¢ aic . = :rn'to once you have completed
accurate, and that you have ac ved o ,..Ery‘thmg you set out to. More informati
intent can be found ¢» ‘1. l r.age Below we have provided a few ideas to ki

—
Stl(lung to e Speuf cation

As advised in the initial ideas stage

(p. 10), create a pitch for your fictional

magazine, newspaper or print

advertisement (think about the content of .

the magazine and the audience you aim to

/ Original Material

Make a list of a
you will need fo
props, costume,
Create a shot i
images you wa

target) product. Tick th
»  Keep note of all the essential elements «  Create a storyb

specified by the NEA brief (pp. 3-4). Tick commonly asso
off each of these elements as you include production but
them in your final product planning and e
. Keep note of all the elements of media secondary phot
language, representation and audiences to think more ¢
you discover in your close analyses. Be surc framing and col
to apply some of these codes and: - Visit your shoot
conventions to yourfmal;r e ensure its suita
e Stick to the brief! .. ’ -y a5 a recce (visit

g{’ .‘ to filming)

Eéﬁcﬂ‘}oa

Loglstlcsﬁ NS
Create a timeline of the entire process.
(Start by giving yourself 30 hours. You can
always run over.) Use this to ensure that private propert
you stick to deadlines and leave enough permission fron:
time for shooting, digital composition, etc. e Think about the

«  Create a ‘to-do list’ which you can tick off and objects wit

conditions? (thi
tone of an imag

throughout the process. (You may find it (mise en scéne)
helpful to split this list into subsections, e.g. K
images, written content, editing.) /

»  If you are planning on completing primary
research, ensure that this is scheduled
properly in advance as you will be relying ¢ .
other people to collect your data. .
(Secondary research and th..a. \ ' riting advertisement.
of content can be...i' “un'a flexible time when it co

Tfa; ?2,!,;; adv;r; (Crlg)d shooting must product.) o

e +  You may find it

e that you keep track of everyone

involved in your practical project e.g.

lighting operators, models. Their names will

need to be included on the cover sheet you

lavoutand Design
As advised in th
" {p. 10), produce
magazine / new

magazine / new
advertisement.

hand in \ composition an

. v
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Statement of Intent

Writing a statement of intent on top of your practical project may seem a little
daunting at first but it shouldn’t be too difficult provided that you research and
plan your projects effectively. The statement of intent essentially gives you the
opportunity to point out the most relevant and exciting parts of your practical
project to the examiner. It should only be approximately ’-".”‘ words in length.

.

You can produce an effective statement r“' oty early |dent|fy|ng the most
relevant aims of your project, as v it 1 Y ways in whtch they fulfil the brief.

Take it as ang
e  Howw
10 infor \e#G(

conventions of media 1anguage in your project and why?)

e  How you will utilise your knowledge and understanding of representations
(of people, places, groups, events and ideas) in the media to inform your
own constructions of representations in your product (i.e. how will you
challenge or subvert stereotypes and why?)

These descriptions should be backed up by the knowledge you gain from your

research stages (into other products, your target audience, and theoretical

perspectives) to explain your decisions. Most importantly, you need to explain:

e  How your product effectively communicates meaning and why it meets the
stipulated brief

1 V.;“Au.ﬂDIC Srarcmcm of Infent
[ aim to produce a fro . ‘w and a feature page for a reg:oma{ broa

the comtent“m similar media products, such as 7The Daily Telegraph a;

story will focus on a 19-year-old man who has just become the you
elected in his constituency. In adherence with the set brief, the secon
explore further aspects of the Conservative candidate by covering an
made at a local secondary school. Through annotating similar media
include a headline that is simultaneously punchy and formal, a stand,
information, and a striking main image of the candidate staring into
have decided to produce the newspaper with a red, white and blue ¢

connotations of Britain and a sense of national = [ have included

large chunks of text, and pull quotes te sh /w - _wriety of political op

and wake the standard of joro. < & Seem more legitimate (this is a
broadsheet pub :ca%v L also included “The Wolf of Wilson Str:
tn e Wo//" of Wall Street starring Leonardo DiCa
1 overed that many young adults (From both sides of th

referenc

research, o
that tlf\ere is under-representation of disabled people in politics. | pla
by casting someone with cerebral palsy as the politician. This decision
who never lets his disability stand in the way of his strong-minded a
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Practical Skills

Typography

Typography: The style of font in a media product Th i o atributes to the p
house style. .

Font ~
In any form of print-basz2 4 /(. quetmg, the style of font is crucially import
terms of crege o W ot audlences and capturing the style, genre and ton
particular g 11,&@ Tné typography must also be visually appealing so as to catc
people’s eyc\a#®ie first place!

When you come to create your print-based product, be sure not to just rely o
same old fonts:

Calibri (Body) Cambria (Headings)
Comic Sans MS TRAJAN PRO
Arial Times New Roman

The fonts listed above are used time and time again in print media so you must
that your font stands out from the crowd.

There are dozens of websites which offer downloadable fonts for free. Be sure
website you plan to download from so they can check the f~: is you use are co
websites can be found in the Further Reading secﬂc Wy x 42

Designers of print advertisements will nf‘ | ours perfectmg the typogra
how much information dESIgnP"S ,u.a -+ .y simply through the choice of font.
meaning are estabhsheﬂ A meg slogan fonts:

Type of campaign: Supermarket
class adults looking for high-quali
Effect: Sharp slanted edges to th
upright design, connote elegance

Type of campaign: A campaign b
on the rights of veterans to recei
Effect: Use of bold font with wid
very clear to read (appropriate fo
strength, appealing to the braver

1 Type of campaign: A charity-led

while also invoking a sense of urg
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~
ACTIVITY 1.1

Written below are four brief summaries for made-up print advertisements. For :
come up with a catchy slogan which appropriately summarises the aims and t
completed, apply an appropriate font to each slogan which you feel would he
intrigue of the target audience. The briefs are as follows:

1. Agovernment-funded advertising campaig (& | isplayed in schools a
discouraging teenage boys from b .1 guwolved in urban knife crime

g .ipt)p“'éulture magazines) promoting an up
; around films and music (target audience: 16-25-y

2. Print advertisement /.
whose cagteri - -

b - : b
My sement (running in tabloid newspapers) promoting a new Ita

3.  Print
s -
(targe™®udience: families)

4. Advertising campaign (running in lifestyle magazines) initiated by a wom
suicide attempts among middle-aged women

AdOD NOILO4dSNI
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Text Dimensions

We have already established that print marketing, newspapers and magazine co
codes and conventions, all of which help to convey mean’ - ir the audience. H
consider how the dimensions of text affect mean’ " ¢ 7sw tont size and posit

L Activity 2.1
' :;oi}'ér of Q Magazine closely.
e Rank thie following codes and conventions by their prominence on the fro

line (3) Other coverlines (4) Barcode (5) Puff (6) Main image (7) Dateline (
e  For each ranking, describe how the code or convention appears on the co

its size and positioning on the front cover.

B BIGGEST MUSIC M

e L
\#ion Activity: Remember that it is important to choose

the appropriate typography for all elements of your print
product, not just the title and the masthead. Repeat Activity you pla
2.1 of your choice, ranking the cover’s codes and

conventions in order of importance. design

certain
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Stylisation

Stylisation: The intricate aspects of typography used to add further meaning
i appealing for audiences.

People who design magazine covers professionallv wi' . .y iettle for an uned
Publisher. They will make subtle edits to mee te ‘ «xd Out among the comp
these more intricate aspects of tyn~w w ay + .~

Italics
Explanation: Commonly used in o
particular words or to make cert
sentence. More so than bold and
add emotional meaning to a pa
‘sexy’ and ‘body’ invite connotat
turn making the stability of ‘won

P

Bold
Explanation: Used to make certa
used to emphasise certain words
too many words on a page are
becomes meaningless so it should
The importance of the message i
secure font.

Underlininr ..
Explzn - an Used to place emp
{ i obscure words and (

covers and in print advertiseme
among bold and italic typeface
seem more secure and reliable,
hand-painted quality.

AdOD NOILO4dSNI

Kerning

Explanation: Refers to the proce
individual characters in order to
design e.g. observe the space bet

Analysis: Kerning has a sinister e
or perhaps that something is bro

Tracking
Explanation: Also known as lette
of adjusting the space between
consistent density within a whole
ensure that taxt fits proportiona
readak’ 1

COPYRIGHT
PROTECTED

& o raéking makes masthe
Giegance. Allows for more text t

'9

Line Height / Condensing Text

Explanation: Line height refers t
on top of one another. Like trac
ensure that text is readable and
to the space between letters.

)

Education

Analysis: Line height is used to a
audiences read the advert (pict
height of the two instructions ma

HOWTO BUIRD A LASTING RELATIONSHIP:
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. Activity 3.1
ti.2 following elements: use of it
‘awrwhether these elements of typograp

Annotate the two media products pictured below with r=731 nc
choice of e ot
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0K! (Magazine) © Reach PLC, 2010
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Eego Star Wars © 2015
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Colour Schemes

Colour is one of the most important indicators of meaning in print-based
marketing. Colours carry dozens of different meanings and connotations.
Media producers are highly aware of what audiences associate with certain
colours and will use this knowledge to make the tone and genre of a print-
based media product clear, based on a single image. You e 1 apply the same
logic to your own print designs. -

When you combine two (or more s 5 . -+ sether, you begin to hone in on
which connotations you _mour choices to convey to an audience.
For example :, v rries connotations of fove, passion, blood,

l. you juxtapose red and pink in a design, audiences will
typically assXa#e red with love and passion in this context. However, if you
were to combine red with black, audiences are more likely to associate red
with blood and danger.

Below are some common connotations of different colours:

Red - Love, anger, passion, danger, power, sexuality, courage, fire, blood
Purple — Reflection, wisdom, royalty, luxury

Blue — Peace, masculinity, responsibility, conservatism, cleanliness
Green — Growth, health, safety, wealth, greed

Yellow — Youth, energy, confidence, sunshine, cowardice

Orange — Warmth, excitement, joy, youth, self-indulgence
White - Innocence, purity, cleanliness, perfection, safety..

Black — Mystery, strength, power, danger, evil. fo: né t\/ N eath
Brown — Earth, stability, nature, dirt, /' -

- m A_,\.,.bm‘ty“x

Pink — Love, femininity, nurti o

ACTIVITY 1,1

Taoke @ pnn'r advertisement or magazine front cover of your choice and redraw it
scheme. Analyse the differences between your design and the

Colour and Representation in Magazines

The magazine industry has a long history of stereotyping. Producers will often t
people who fit into a particular age group, class or gender. Certain colour schen
appeal to certain audiences. For example, if you were to Google: ‘magazines for
covers you would find are overwhelmingly made up of pinks, yellows and light b
Google: ‘'men’s magazines’, the covers you would find are overwhelmingly made
and whites. :

The effect of colour schemes on representation ir it - Aé‘p,.:;od'ﬂcts is important f
establish rules which are so universallv gy o inv«estern society, e.g. blue fo
aiming for a band 5 will need toredls \ Luucts which challenge or subvert ster
to experiment with cnlr € es and discover how they shape meanings and
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ACTIVITY 5.1

This issue of Glamour Magazine is clearly catered to a femal

a)  Annotate the magazine cover explaining how the colour scheme is used to cate
dudience
b) How would you change the colour scheme of this cover to mcke it less stereotyp
\ should be no more than 100 words. s

r long
distance love
can be tough

AdOD NOILO4dSNI

Cheryl off
1e fopspot?
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Layout

3

ﬂ’ ;: WERR, Bugg

White Space

A term used to refer to the
empty space between text and
images in a composition. It is

Balance
You do not want one section of your
page to look overly cluttered while
another is made up almost entirely
of white space. This will make for a
chaotic and unsatisfying design in the
eyes of the audience

easily readable and for
adding an air of luxury to a
design. However, too much
white space can make your

design appear dull and lacking

in information

Tips of the trade for
layout and design

AdOD NOILO4dSNI

Contrast
Describes the way in which
various elements on a page
visually complement or clash with
each other. Try to ensure that you
have an appropriate range of
textures on your page and that
colour schemes of your images
complement one another.
Furthermore, be sure to include
images on a single page with a
range of densities and
complexities, e.g. pairing h«
rich, complicated imo =
to overwha's: A e

O sy
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Photography

e Create a ‘to-do list’ relating to all the photos you need taking for your p
as you shoot them.

o  Make a list of all the necessary resources you Wl” nee: 1 for your photos
costumes, models, lighting equipment.

e Produce a storyboard. Storyboarf‘" Vs '%; . ura'r;lyﬁuseful for planning

. “,_..Jverttsements Unlike shot lists, sto

o |f you are shootmg outdoors, check the weather conditions beforehand
will look very different to an image taken in sunshine, e.g. if you are sh
making intertextual references to Gothic horror films, it might not be t
beautiful, sunny morning.

e If you plan to shoot images on private property, e.g. a café or a museu
permission from the owner of the property.

e Experiment with different perspectives beforehand. Prior to your shoo
practise shooting the same image from a wide range of angles. Analys
don’t. Unconventional images can make your images stand out among

e itisrarely a good idea to use the flash device on your smartphone. It is
what your natural sources of lighting will be. Will v~ need to book ou

centre beforehand, or can you create anir’ > #s . i_? Ilbhtmg design usin

lamps, fairy lights, glow sticks, ef’
e  Make sure your iens is ot E u,. & cameras can often gather dust an

This will nege‘l 5 A tie quality of the images you take.

AdOD NOILO4dSNI

What if | want to shoot with a DSLR?
This pack is tailored towards students who plan on taking photos with a sm
generally be far more accessible. However, you are more than welcome t
your cenire own one. The following websites offer useful tips for those gett
cameras:

o  hitps://www.wikihow.com/Take-Good-Photos-Using-a-DSLR

e  hitps://digital-photography-school.com/megapost-learning-how-t
e  hitps://[www.youtube.com/watch?v=9DQXIRpY2qc

— COPYRIGHT
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Mise en Scéne

Mise en scéne refers to the arrangement of people and objects within the fram
associated with the analysis of audio-visual media, it is something worth consid
take for your print product also. Whichever media form you choose to create,
original images that help illustrate the kinds of stories and messages you are tr
narrative information, invoke tone and construct represer*.* bns of people thr
which they are framed. You would be surprised hr*;,.'., i jfm.armation can be

When it comes to shootmg your i L il have to think about: how acto
actors/models wear; hov o ,,meg, ‘which objects surround them; which
s 1eth|ng else?

Genre: Tiig’ formall’ry of the situation and the
lack of Photoshop interference suggest that this
is taken from a broadsheet

Sefting: The backg
Union Jack flag and t
meeting concerns im

Character:
Theresa May’s
body language
is more
introverted
than Donald
Trump’s,
suggesting that
she is more
intimidated
than him by the
meeting

SN

Narrative: The action code of the leaders
shaking hands implies that they are making an
agreement and that they are in alliance

Costume: Both leader
connoting a profession
Trump’s America

ACTIVITY 6.1

Observe the way in which the image from The Telegraph (2018) has
its mise en scéne. Take an image from a newspaper of your choice
the arrangement of people and objects within the

‘en scéne is primarily discussed in association with fil
) !euiu it can also be applied to images in magazines and prm‘r

W. i A";Q,,.‘

Think about the way in which they are always positioned to
face the audience and give them direct eye contact.
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Six Tips for Shooting

If you are shooting your images on a smar:
which display a visual template of the ‘rule
of interest fit into the provided boxe
: balanced and visug
g5 Photos & Camera
-j walaxy: Camera > Sett

Make sure you focus on your main subject
tap the section of the screen you want to
will traditionally be th

Symmetry is satisfying: Images which con
to print-media audiences. Not all great p
but it can be a highly effective trick
professional-lool

Pt w

ng in can spoil the photo: It is alway
ge rather than zooming in from a dista
t lesing its quality and becomir

Make sure you have something to rest on
on a iripod, there are still ways to keep y¢
walls, fences, even a large pile of books!
surface are likely to look

y

Experiment using Image Editing Apps- T
which can be us2.2 ‘make your images i

your photos connote a pa

The following apps are recommended
FaceTune, PicsArt, Aviary, Adobe Lightre
Afterligl

You can also edit images on prograt
Microsoft Publisher and even Microsoft

\ using these pr:
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Shot Types/Framing
Framing describes the position of the camera in relation to the subject. Differen
of perspectives of a setting or person, providing additional insight to the audien

Extreme long shot

@

Shows « large amount of the scene 1o e .o . :ﬁthcﬂg;j"enerczl location.

Long shot

This type of shot still contains the scene; however, it gives the audience a
more specific location of the action.

Full shot

Shows the entire height of a person within the frame, allowing the
audience to see the subject clearly.

Medi".: A nc % ,,,,, =
Contains a view of a perse= = 1 t~¢ waist up. It allows the audience to
see the persons foo 1., 9¢,“language more clearly.

AdOD NOILO4dSNI

Medium close-up

Includes the face and shoulders of a person. Allows the viewer to see
the person’s emotions.

Close-up

COPYRIGHT
PROTECTED

A very intfimate shot where the background is out of focus. This allows
the audience to concentrate on the subject’s face, emphasising their
facial expressions.

g

)

Education

1%9 1 i sunse mood and draw attention to a specific part of
o

the subjeci .
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Over the shoulder shot

This shot is usually used to show conversation. It allows the audience to
see the person’s reaction and implies a degree of intimacy between the
subjects.

b kol e view of the subject, used in order to make
o8 \I us'if they are part of the photo.

Aerial shot

This refers to a shot from above, showing objects such as cars and
people below.

Angles

The angle of the camera in relation to the subject car -y - ac Jitional emotional
example, it can impact how the people or scene :;r"'e’f’ sewved to the audience.

AdOD NOILO4dSNI

This is ¢ ¢ 69
greater th Eé"‘ °} and o short focal length. It can be used o show a wide
landscape and also physical distortion between objects, which is particularly
relevant when close to the photographic subject.

Low angle
The opposite of a high-angle shot, the camera is low and shows the subject
from below. It's used to make the subject appear powerful and
domineering, as they fill the frame, creating the impression that the viewer
is a helpless child looking up.

COPYRIGHT
PROTECTED

Hirl ¢ ag o
The camera is positioned un e Csr 1 ‘woks down af the subject. It has the
effect of belittling the & & ~wxing them appear as if they are a child
looking uzslilr ¢ @ . -

'S
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Eye-level
This is a standard view, showing the subject neutrally in a way the audience
would expect fo view it in person.

. . Canted angle
A canted kW oen The camera is tilted on its roll axis so that the horizon
is at an ai th the bottom of the frame. It aims to disorientate the
viewer and portray emotional tension.

Editing Images

Scaling

Scaling is a tool that enables an image or shape to be resized — from a reference
you can enlarge the object by dragging it outwards or shrink it by dragging it inw
It should be noted that increasing the image size generally has a positive correla

file size — meaning that the larger the image, the larger the file size.
While it is possible to enlarge an image safely, rescaling b~ .d a certain point v
show a noticeable decrease in quality and could s-. 5 /e ; én.

t

particularly evident when enlarging low-r2s * tc / aag

Cropping ‘
Cropping arg 2 i3 ting an image down to a specified

crop an ima ¥®it it to a specific dimensmn or to enhance the
composition. Sometimes cropping involves trimming away a little
detail around the edges, or you may isolate a small component of
an image and discard everything else.

Cropping an image does not change the resolution or image
guality; it only shrinks the size of the canvas.

Contrast

Contrast means the difference between two states, in this case
referring to the difference between two tonal ranges — increasing
the contrast makes dark tones darker and light tones brighter.

The photographs to the right show an example of 24/ .5 4 c ntrast
and brightness. The photograph on the left’s fa.* 20 .dnclear; by
reducing the contrast and increasin’ we b1 ¢ riess it increases the
amount of grey and makes *>, - hlf" ‘ uppear clearer.

i

Levels
Levels aHov\ ,;ser to adjust the tonal range and colour balance of an image;
intensity Ievew of the shadows, midtones and highlights. Look at the example b
detail in the highlights, an underexposed image has detail in the shadows and a
has detail in all areas.
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Underexposer! -4 ; Evenly exposed

O
[

i

Ly

Colour adj ks
Different im=®2=manipulation software may have different tools and
options for colour management, but all produce similar outcomes. Colour
balance is a measure of red, green and blue in an image and can be used to
simply change the colour of an image or correct other mistakes; for
example, correcting photos taken at an incorrect white balance.
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Software-specific Skill

Microsoft Publisher

Microsoft Publisher is very similar to Microsoft Word, so if yor! have never used
Microsoft Word, you should find it pretty easy to navit % L %imately, Microso
on page layout and design than Word, which i~ m ire " d to
all of the same shortcuts as Microsoft Y/ sro . )

«d towards text comp

Youzan <t -+ . vf/ _ocliment from scratch by opening up a ‘blank’ dé:
th © Jucument to any page size you like. Go to ‘Page Design’

You can aiso use templates. When you open Publisher, it gives you a &
advertisements, banners, brochures, etc.) which you can use and cus

Use the ‘Insert’ tab to insert pictures/images. Navigate to the folder
can also copy and paste images into Publisher using the standard sho

Resize, crop, align and change the effects/colours/brightness/contra
image. This will bring up the picture tools ribbon where you can cha

If your document keeps crashing, it may be because your images are
you can reduce the resolution of one, several, or all pictures by comp
images, right-click on an image, select Format Picture > Picture > Clic
do not compress your images too much that the quality of the image

To add text use the ‘Insert’ tab to insert textboxes. Click on ‘Draw Tex!
the space provided to create the textbox. Type into the textboxto a

Change the font, size, alignment and effects ol . .. soxes by selecting
the ‘Text Box Tools’ ribbon where you - aii ‘e ;Qe these options.

Use the ruler to place and a'ie - 1s anid insert guides. To add guic::
on the ruler Where wa 1 yedf gmde You can insert vertical and
helpyoutnc' 4 o) s’ “These guidelines are only there to help you

O | 00 [NO| O AW —

13, ) w,;uitex'cboxes by selecting the images/textbox, click on
.3ect ‘relative to margin guides’. From here, you can go back t
topof the page, the bottom of the page, centrally, etc.

o

You can also send textboxes and images ‘backward’ or “forward’ by ¢
and navigating to the ‘Home’ tab.
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Microsoft Word

As pointed out on the previous page, Microsoft Word isn’t as ideal for print desi
are really not confident using Publisher, don’t let that put you off of using Micro

You may thirk that you already have a good working knowledge of Microsoft W
surprised to learn that Microsoft Word has pretty limitlesc f - ctions. You might
can accomplish on Microsoft Word. Below are sor; = it “useful functions of U
aware of; functions which will |mprove yr:,j* bolgis, deugn and presentation.

= —

.,“opening up Microsoft Word and selectlng

Createanewd 2 -

N

,u

‘CTRL + Enter’ to insert a page break quickly.
Use section breaks if you wish to insert a new page at a specific point of
page layout (size, orientation, etc.) to be different from the page before
your cursor where you would like the new section to begin and then sele
Page’. Once you are clicked on your new page/section, you can change t
size from the ‘Page Layout’ tab, without it affecting the previous page!

Insert images by selecting the ‘Insert’ tab and navigating to the folder w
also copy and paste images into Word using the standard shortcuts ‘Ctrl
Edit the size, colour, brightness and contrast of images by selecting the
open up the ‘Picture Tools’ ribbon, where you can crop images, apply eff

When creating a document that has a more complex fayout, it is best t
rather than just typing straight onto the page. This way it will be easier t
page. To insert a textbox, go to the ‘insert’ > ‘Te = x’ Click and drag i
textbox. Type into the textbox to addte o

You c¢an apply text effects to te \; : *hn.bfmng the text with your curso

text effects icon: 12 am j_ you can apply shadows, glow, text outlin
insert shapas’; A . _auument by selecting the ‘Insert’ tab and then ‘Sh
il w\ .« insert. Click and drag in the space provided to creat
ié&aw rlght clicking on the shape and selecting ‘add text’. You cana
angratignment of shapes by clicking on the shape. This will open the ‘Dra
access these options.
If your document keeps crashing, it may be because your images are too
9 reduce the resolution of pictures by compressing them. To compress im

to compress. This will open up ‘Picture Tools’ ribbon where you have the
sure that you do not compress your images too much that the quality of
You can group images, shapes and textboxes so that you can select multi
] 0 around on the page. To group objects, select all of the objects you wi

selecting them with your mouse. Then navigate to ‘Picture Tools’ > ‘For

AdOD NOILO4dSNI
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Navigating the toolbar in Microsoft Word can be both g ng and time-consu

you can use with your keyboard:

F4 = Repeat last function 6l “

Ctrl + Shift + C = Copy formaigesds”
Ctrl + Shift + V = Paste.f@@ie

Cirl + A
Cirl + 1
Ctrl + 2
Cirl+ 5
Cirl + L
Cirl + R
Cirl +J
Ctrl + E =
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Cirl + Enter =P
Cirl + Shift + End = Select from that point until the end of the document
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Adobe Photoshop

Photoshop is a fantastic tool for creating, editing and retouching images. Many
transform their photos with eye-catching effects. You may be using Photoshop
taken for your print-based project only, or you may be using the program to cre
any text you have decided to include. Below are some top tips for those new to

To create a new document, go to ‘File’ > ‘N
] document. From here, you canalen = the - “ ,Oxuflon and colour mode. Al
above, and the colour me2-. o ’N U trie same colour system that printers
To insert photow;

oDy (fave taken lnto Photoshop, open the folder

Save images in TIFF format (industry standard for print-based materials). Y
format to make the best use of transparent backgrounds.

If your document (in whichever program you are using) keeps crashing, it m
high a file size. Therefore, it is important to compress your images (withou
To compress images in Photoshop, go to save your image. For TIFF images,
(works well across a number of programs). For PNG images, select ‘Smalles
Make use of layers. Each layer relates to an image on the screen, allowing
layers by selecting ‘layer’ and ‘new’. You can also make layers transparent
You may also need to group, duplicate, delete and merge layers via the laye
Use the History panel to revisit changes that you made to the document. Y
made from the History panel. You can also compare and contrast earlier/la

Use the crop tool to resize any images.

O (O N OT] A (O N

~_irom the pmnt on the ruler where you want your guide.
‘ and wnH not be prmted

] 0 contrast, exposure, colour balance and vibrancy of your image (and more!).
pixelate, distort, sharpen and stylise images (and more!).

] ] Use the swatch library to collate colours for your project.

-I 2 Use the eyedropper tool to select colours from an existing image and add t
library.

'I 3 Use the magic wand tool to select areas of the image where the colours are
particularly useful for removing white backgrounds.

Use the shape tool to create shapes. You can change the fill colour of the sh:;
] 4 colour and thickness of the shapes stroke {outline). Once you have drawn t
wilt allow you to specify the size/dimensions of the shara.

Use the text tool to create textboxes and chang *! ~ ‘o t, size and spacing
] 5 tool and then click and drag in the spac2 p J L Ml 'c;‘create thetextbox. T
and highlight it using the cursen 5 s any’ adjustments
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Adobe InDesign

InDesign is part of the Adobe group, as is Photoshop, so they operate similarly.
Photoshop in that it is less about editing images/photographs and more geared
documents such as magazines, etc. Many graphic designers and production art
different forms of print media. Below are some top tips for those new to InDes

To start a new document, go to ‘File’ > ‘New’ > ;, e at’. From here you
many pages you need, what size thev s ov d t‘«« i whether the documen
pages (good for double- page~ rac: - ou ¢an also change the size of you
A bleed is the area iu*f,‘ en I ,./dSt the edge of the page and is helpful if
background oz cia 2 +age which you want extending off of the page.
Y / 4‘.~ounds) that you want to run to the very edge of the pri

’Dlspi‘ay Performance’. We recommend working in Typical dlsplay as it’s fas
you want to see the final quality.

Use Pages by going to ‘Layout’ > ‘Pages’. Pages lets you select/add/delete
pages. You can rearrange pages by simply dragging them around in the pag
pages to put the same content on each page — works just like headers/foot
a master to a page, drag it onto the appropriate page on the Pages menu.

Add guidelines to help you line things up. Drag out from the ruler to add gu
between preview mode (final version) and guidelines mode (where you can &

InDesign will automatically suggest align points by flashing up a purple line
parts of the page (e.g. when you reach the centre of the page or the edge o
objects by going to ‘Window’ > ‘Object and Layout’ > ‘Align’.

Don’t copy and paste an image into a document — instead use CTRL+ D to
save all of the images you wish to use into a folder, T * sou should not chang

Images are automatically put into ‘frames’ .. X _‘lke ‘crop areas. Blueo
seiected. If you resize the image vit:t o, ':.elected the image will be
have the image selected e S
SHIFT + CTRL+drez.t

InDegion jopt 0
: aa bl ‘, e anywhere on the document and drag to p%ace the text box
té&“‘“o“

'~

To'gud text effects, you have to add effects to the text box Select the text
and go to ‘Object’ > ‘Effects’. From here you can add shadows, glow and gr
same for images too.

Use the pointer tool to select an object, and the type tool every time you w

Use layers by going to ‘Window’ > ‘Layers’. Layers lets you select/add/dele
areas of your document without affecting other areas.

Use the swatch library to collate colours for your project. Always use CYMK
creating colours (the same colour system that printers use) for print-based
need to select whether you want to change the colour of the ‘frame’ (outlin

To pick a colour from an existing image and add it to your swatches, use th

To create shapes, use the Shapes menu. Rez*z g ¢ fﬁqt,.ares and circles/ov
simple — use the rectangle/ellipse to! To "re il triangle, use the Polygo
click anywhere onthe page 7! £t . 9. .aumber of sides. To create a star,
Polygon tool and clicl:or ii‘/v"ht ~orr'the page. Select 5 or 6 for the number
Adjust the stz “'\"gl.;{'t __reate a thinner or fatter star. To create other shap
“tp . w.ansimonsezit.com/article/working-with-anchor-points-a
._ wtn-"i‘ndesign-csE/

Rotate objects by hovering over a corner of your shape or image; hold dow
degrees. You can also rotate and flip objects by going to ‘Object’” > ‘Transfo
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Sure-fire shortcuts!
Navigating the various features of InDesign can be both confusing and time-con
you can use with your keyboard:

Citrl + Shift + Z = Undo last action Cirl + A
Ctrl + Shift + C = Copy formatting

Ctrl + Shift + V = Paste formatting

Ctrl + —to zoom out

Ctrl + = to zoom in

Ctrl + G = Group objects

Shift + Ctrl + G = Ungroup obijects o 3 Shift +
Shift + Ctrl + [ = Send an objecie€Te Shift +
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Glossary of Terms

Narrative codes embedded in a media product w
the story

Action Code E

The main body of text descr-h > [ the benefits and

Revealc .l i . u A,.Aient”és are permitted to view th

“When one aspect of a media product aids in the e

e - SRR D U

A character in a story who opposes the protagoni
narrative disruption

Black, Asian and Minority Ethnic — this phrase is u
white people

A code easily read by a machine usually situated i
media products, e.g. magazine covers

A type of newspaper that tends to tackle more se
culture and the economy

A system of features or rules used regularly acros
same style or genre :

When a media organisation promotes a product
media form

Situated on the front cover of most magazines, th
publication

A subsection of an audience determined by unch
gender and economic status

Borders {often of a different colour) drawn aroun
text to break it up

Genre . The style or category of an art or media product

GCSE (9-1) AQA NEA Practical Skills Pack: Print Page 39 of 46

AdOD NOILO4dSNI

COPYRIGHT
PROTECTED

'9

)

Education




Gradient : A range of position dependent, fluid colour patterns

individuality to designs

1
. The way in which a media organisation presents its
. recognisable manner

D Infor at 3 Jn"’d ‘iun the newspaper that contains t
Ly mformatlon In some cases, key members

The process of adjusting the space between words
vertical column

Refers to the process of adjusting the spacing betw
order to achieve a unique or pleasing visual design
Refers to the distance between lines placed on top
line height is considered to ensure that text is read

One of the titles from the cover page of a magazine
important coverline and will often correspond with
that issue

Magazine covers typically feature one image (also k
often of a celebrity, that ties into the themes of an

The title of a magazine puhll ’
each issue ‘

Typic~!

The state (usually at the beginning and end of a sto
balanced. There is no major conflict.

A way of categorising genres in more detail. Niche
combination of two genres, e.g. teen sport, women

' Refers to research you will conduct yourself in ordet :
. specifically related to your own project

! A subsection of an audlence ~~. ‘mined by psycho

! Also kn’,, ahias ,‘“;p.asﬁwAn added incentive featur
' ire  uftén contrasting in style to the rest of t

ﬁiéces of information located on the outer corners
used to attract the attention of the audience and d

Short, attention-grabbing quotations from the feat
to highlight key points or make the page more visu

Pull Quote
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The process of visiting a filming location prior to s
suitability

A key characteristic of several British tabloid news
their red mastheads

The intensity of coloursinar ! ige takenonaca

il géfher from the pu

Refers to inform. tic

‘:f y urticle placed on the same page as a m

e e e e e e m m m E —E—, - —————————— == === =

i/ Information provided by a person or persons, usu
. more legitimate

. . A hook or tagline used to gain audience interest, d
Strapline | .
i the issue
______________________ e e e e e e e e e e e e e e e e e e e, e, e, —— - - -
Subheading . Headings which separate bodies of text within a f
Tabloid . A type of newspaper that caters more to the popu
Ta ' Phrases used to catch the audience’s attention on
g . or ‘Exclusive!” Also referred to as buzz words
Tagline/Slogan : One punchy line which ensures fhat the advert is
| memory ~
______________________ U R g e i o m m e =
. A magazine cce s ‘l‘ ;o' split into three equal h
Thirds : called *'. (5. | eve are used for selling purposes

"Also known as letter-spacing, this refers to the pro
between characters in order to maintain a consist
of text.

Style of font on a print product. This brands the p
particular genre.

A term used to refer to the empty space between

White Space .
composition

o
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Further Reading

Print Marketing - Design

e  https://smallbusiness.chron.com/7-elements-print-advertising-15325.htm
Advertising

e  https://www.canva.com/learn/print- advertnsmr' ‘4 5, — 50 genius print
techniques 4

e http://fwww. med:aspacesolutm' Lo A,ag/6"—absoIute-rutes-of-effectiv
Effective Print Ads oL

e  https: //blmne“"t Vo ;sj‘pl;-a/'i79-ruIes-for-creating-more-effective-print

. https://www.youtube.com/watch?v=lszQEdLUAY — Useful Tips for Desi
e https://www.creativeblog.com/inspiration/print-ads-1233780 — The Bes

Newspapers - Design
e  https://www.youtube.com/watch?v=zHuH8P_Vqc0 - Jacek Utko: Can desi;
e https://www.makemynewspaper.com/uk/modern-newspaper-layout-des

Layout Design Tips ‘
e  https://www.canva.com/learn/editorial-design/ — 50 incredible editorial d

Magazine Covers - Design

e  https://www.creativebloq.com/graphic-design/5-essential-cover-design
design tips (Creative Blog Staff, 2015)

e  https://www.canva.com/learn/magazine-cover- dec"' * =50 design tech
covers awesome {Rebecca Gross) '

e  Book: British Magazine Design, Anth=~ ~ J‘ilf,;,,,f.zul"fi,'

:

e  https:, ié :voutube com/watch?v-e 4B-h]bAyA — How to make a mag g
(The Me™8 Designer, 2016) '

e  https://www.youtube.com/watch?v=Gez3Rr5PvdU — Photoshop Tutoria
Cover from a Photo of Someone (Blue Lightning TV Photoshop, 2013)

Magazine Double-page Spreads - Design
e  http://www.magazinedesigning.com/55-best-tips-for-a-sucessful-magazir:
55 Best Tips for a Successful Magazine Cover (Nikola, 2015)
e  http://www.magazinedesigning.com/magazine-spreads-good-bad-pract
and Bad Practices (Nikola, 2013)

Magazme Double-page Spreads ~ Practical Skills
https://www.youtube. com/watch‘?v-yghWGGQ " v signing A Double :
Media, 2016) , ;

e  https://design.tutsplus. com/tu*' qas s - ,,;-to-create -layouts-for-a-fashior.
€ms-22860 — How to Cre: :'avf 1 10F a Fashion Magazine in Adobe InDeS§

on ety

Theory/ (on T X
Book: VREG®® No Longer Talking to White People About Race — Reni Eddo

Black Planét
e  Book: WJEC/Edugas GCSE Media Studies — Hayley Sheard, Illuminate Publi
e https://www.youtube.com/user/NewWorldOps/videos — Photoshop Tuto
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Indicative Content

Activity 2.1

The order in which you rank the codes and conventions is subjective, although t
main coverline should be ranked towards the top and the =

towards the bottom.

Masthead: Appears in

the top ieft corner of the
cover page. Due to tho
fact that it
letter, it is

significant portion of the
page. Some magazines
have images covering
the masthead but Q
magazine brings the
masthead in front of the
main image,
acknowledging that the
name of the publication
is reputable enough to
attract audiences

Barcode: Situated in the

left third of the cover, the
barcode takes up a very

small portion of the page.
It is never the main selling
point of a magazine, mo-
of a formaiizgm "

Dateline: QU %arly the
least prominent element
of the front cover. This
appears inside the
barcode in a very small
font in the left third of the
cover. Only audiences
reading very closely will
focus their attention on
the dateline

T MUSIC MAGAZ

Hine, barcode and

zmé) © Bauer Media Grou

20

Main Image: Quite ciearly
the most prominent
element of the front
cover. Cheryl’s face
occupies almost the
entirety of the cover’s
surface area. All other
codes and conventions
are layered over the
image but the central
third is left empty for the
main image to maintain
prominence

Main Coverline: Writt
in a variety of fonts, a
fairly large. The main
coverline appears just
below the main image
spreading from the

middle third of the

magazine. It is likely t
the audience’s eye lin
will move from the m
image immediately do
*~ the main coverline
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Activity 3.1

Indicative Content: These annotations are by no means

OK! Magazine

Bold is used in the title: ‘Celebrating b2
engagement with OK! to make... -
out and compeng

interviews). The name: Natalie Cassidy
also appears in bold. Usually in print
publications, names are emphasised in
italics but bold is more effective in this
case as the name appears against a dark
background

No use of underlining: Rare to see in a
magazine publication — emphasise”’
words are written in bold

Line Height: At its largest in the picture
caption and the main quotation.
Increased line height makes this text
readable against the dark and textured
background of the main image

ex' . fv

OK! (Magazine) © Reach

Choice of font: The title font is used
across all OK! publications. The font is
simple and easy to read. Throughout
the story, the tall, elegant font matches
the subject matter: we” ' and

=

Text Dimensic:
is organised i
clarity. The st
quotation, su
text progress
right hand sid
of the image
horizontal lin
box
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Indicative Content: These annotations are by no means exhaustive.

Bold: Boid is used quite ; A
consistently throughout the Ay .
advert. It is used effectively at b
the beginning of each caniin s

playing with figures of their
favourite Star Wars characters.
‘master your force’ is a strong,
empowering statement, so is also
emboldened, making it stand out
in the bottom right-hand corner
of the page; in addition, the blue,
electronic texture is a reference
to the futuristic aspects of the
franchise. Finally, the Star Wars
logo is emboidened, connoting a
sense of epic adventure that has
captured the imagination af .. ¢
audiences for Z L

Text Dimensions: The various
paragraphs are
proportionately spaced across
the page so as to detract as
little as possibie from the il
imagery. The large Star Wars .. imu use of italics — the advert is not
logo and the slogan ‘master | ne noudarly emotive or quirky in its design. How
your force” are positioned in 7 .| theword ‘force’ is italicised with the characters
blank spaces, making them 4t leaning forwards. This implies that the audience
stand out as much as the game-players can embark on a journey and dev
individual Lego cigaacte. 5 their skills by playing.

COPYRIGHT
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Activity 5.1

Indicative Content: These annotations are by no means exhaustive.

The masthead, sell line
and most of the
coverlines are written
in bright pink text
connoting femininity
and love. These
connotations are
complemented by the
use of the worga:

‘glamour’ TRy

‘women’, ‘I ar .

Nicole Scherzinger is
wearing a purple dress
connoting wisdom and
luxury

]

7
Whe's knocked
Cheryl off

the topspot?

Wi
to pet the looks

Glemcir {lap

f © Condé Nast, 2011
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